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Abstract 
 

 

The use of the English language continues to be viable and veritable across the countries of the continent, 
even in the non-native environments such as Nigeria, Ghana, and India, where English is the official 
language. As an index of achievement within these non-native contexts, there is a great premium on learning 
the various aspects of English. The psycholinguistic circumstances of teaching and learning English in such 
contexts call for concerted pedagogical efforts to satisfy the expected learning outcomes. Thus, within the 
field of Computer-Assisted Language Learning (CALL), an objective of this paper is to identify the various 
technology that can assist the teaching, learning and improvement of the English pronunciation. The second 
objective is to illustrate with the PRAAT software the applicability of technology for the improvement of the 
English pronunciation. Structurally, the paper is divided into two parts: Part One identifies some technology 
generally applicable to language teaching, learning and improvement. It lists 35 types of technology that 
possess the propensity to improve the English pronunciation. This list is divided into four different 
categories, namely: Hardware (13: 1-13), Software (9, 14-22), Hardsoftware (5, 23-27), and Virtual Technology 
(9, 28-35). Some of these are summarised into four Plates (Plates 1-4). Part Two of the paper discusses 
PRAAT as one of the best and most current software for learning, teaching and improving oneself in the 
English pronunciation. It illustrates with 11 screen captures (Pictures 1-11) the viability and applicability of 
the software to language learning, using This is Babcock University, Ilishan. The paper recommends a simulation 
of the native-like environments offered by the Computer-Assisted Language Learning technology for the 
desired proficiency of language learning, at this instance, the English pronunciation. 
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Part One:  
 

Technology 
 

Psycholinguistically speaking, anyone whose language acquisition process has completed or almost completed 
before acquiring/learning another language has found itself in a bilingual situation. This situation has been set such 
that the first used language is called FIRST language while the next one possessed is SECOND, a.k.a. L1 and L2, 
respectively (Mcneill, 1970; Brown &Bellugi, 1972; Brown, 1973; Insup, 1976; Steinberg, 1982; and Jolayemi, 1999).  
In an L2 situation, there is a whole lot of difference in the approach to the teaching and learning of the language, in 
this circumstance, English. One of the hallmarks of teaching and learning English in the non-native contexts is the 
application of specially designed, arranged and packaged pedagogy, tools and materials, called technology. Technology 
usage may have a little application when teaching English to the native speakers; if used to a large extent in that 
context, it is for the impaired native learners.  

 

It is, thus, a very legitimate, indeed, conscious engagement to apply as many types of technology (tech, 
henceforth) as possible to teach the English language in a non-native context, and most necessary for the 
improvement of the English pronunciation. 
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 The application of technology in English language classrooms especially, the use of video, tape recorder and 
CD ROM performs a miracle in the spoken English of L2 learners. It empowers the students to go at their pace more 
so as they have opportunity to replay the teacher‟s lecture at their own time (Oyinloye, 20007; 2010 & 2013). 
Affirming this, the research works carried out at different times by (Adedeji, 2010; Allen, 2011; Dotimi & Hamitlton, 
2013; Oyinloye & Egbuna, 2017) reported internet services as a powerful tool behind students‟ academic achievement 
and teachers‟ delivery in the classroom. To them, ICT is a powerful tool for attaining social, economic, educational, 
scientific and technological tool for developing a nation.  In addition, Oyinloye & Egbuna (2017) report a positive 
result on the influence of information and communication technology on teaching and learning in the Nigerian 
universities, as it is empirically proved that the computer has become a new classroom for the learners. Also, Ihezue 
(2019) stresses that L2 classrooms can only bring out intelligent use of oral English when the computer is fully 
detected, acknowledged and properly administered in the teaching of a second language.    

 

Generally speaking, much work has been done on the needs and types of tech used by teachers. In a Course 
entitled 7374: Introduction to Technology in Schools, Capaldo, Flanagan, and Littrell, (2008) interviewed some 
teachers on the different types of tech they used in the classroom. The answers included: Camera, Camcoder, Digital 
Camera, Smartboard, Search Engines, and the Internet. The others were: Educational Software, Productivity and 
Application Software, Drawing and Illustration Programs, Cell Phones, Keyboarding, and FM System, the last two 
being language tech for the deaf students.  

 

But specifically, much work has also undergone on the applicability of deploying tech in pronunciation 
(Chun, 1998; Shyamlee, 2012; Technology for Pronunciation, 2014; and Wang, 2016). There has also being a specific 
description given to all the computer-mediated tech for teaching and learning a language. This has been code-named 
CALL, meaning Computer-Assisted Language Learning (Chapelle, 1997; Ehsani, & Knodt, 1998; Neri, Cucchiarini, 
Strik, & Boves, 2002; Neri, Cucchiarini, & Strik, 2006; Lee, 2008; Jolayemi, 2013; Pi-hua, 2015; Liu, & Hung, 2016). 
With a resounding success, studies have shown that tech to teach pronunciation has been most rewarding in the non-
native environments (Hincks, 2003; Banafa, 2004; and Hismanoglua, & Hismanoglub, 2010). Thus, a number of tech 
has been designed, experimented with and used (Eskenazi, 1999; Ferrier, & Reid, 2000; and Eurotalk, 2002); and the 
list is endless. In the literature, most of the appropriate tech for the improvement of pronunciation have been listed. 
The following list is from Akinjobi (2017) in a paper for the Speech Clinic: TV, Radio, and Cable news. She also 
categorises some others under Electronic Media Sources (EMS), Internet Sites and Links, Social Networking Sites, 
Dictionaries with Audio Aids, Computerised Speech Laboratories, and Films (pp. 5-9). 
 

Technology for the English Pronunciation 
 

In listing these techs for the purpose of this paper, we shall identify them under four typologies which we call 
Plates, namely: Hardware, Hardsoftware, Software, and Virtual. Thus, below are some of the Technology to teach, 
learn and improve the English pronunciation:  
 

Plate 1 - Hardware: 1. Smartphones 2. iphones 3. TV/Cable 4.Radio 5. Computers: laptop 6. ipad 7. book-note 8. 
palm-note 9. Surface Computer 10.Cassette Player 11.Video Player 12.Projector 13.Smartboards, etc. 
 

Plate 2 - Software: 14. Cassette 15.CD 16.DVD 17.PRAAT 18.SFS 19.WASP 20.Speech Analyzer 21.LINGwaves  
22. ProCoach, etc. 
 

Plate 3 - Hardsoftware: 23. Daniel Jones English Pronouncing Dictionary 24.Cambridge English Pronouncing Dictionary 
25.Language Laboratories 26.Digitised Linguistics Science Laboratories 27.Films, etc. 
 

Plate 4 - VIRTUAL: 28. Internet 29. Website  
30.  www.dialectsarchive.com 
31. http://accent.gmu.edu 
32. www.bbc.co.uk/worldservice/learningenglish/grammar/pron/ 
33. www.uiowa.edu/~acadtech/phonetics/about.html# 
34.  https://app.speechace.co/placement/course/1 
35. Podcast, 36. YouTube, etc. 
 

Some of these techs are summarised in Figure 1, below.  
 

 
 

http://www.dialectsarchive.com/
http://accent.gmu.edu/
http://www.bbc.co.uk/worldservice/learningenglish/grammar/pron/
http://www.uiowa.edu/~acadtech/phonetics/about.html
https://app.speechace.co/placement/course/1
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Figure 1: Technology to Teach, Learn, and Improve English Pronunciation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

            Source: The Present Study 
 

Plate 1: Hardware for the Improvement of the English Pronunciation 
 

Hardware can be described as equipment, a tool or device used for general communication construction or 
instruction purpose. But strictly digitally speaking especially in computing, it is used to describe some parts of the 
computer such as the frame of the Control Point Unit (CPU), and mother board. It is normally static and fixed; most 
of the times, it serves as a host or driver of other items for an operation to be performed. This description includes all 
of the items in Plate 1; and examples are 1. Smartphones 2.iphones 3. TV/Cable 4.Radio 5. Computers: laptop 6. ipad 
7. book-note 8. palm-note 9. Surface Computer 10.Cassette Player 11.Video Player 12.Projector 13.Smartboards; and 
even more. 
 

Plate 2: Software for the Improvement of the English Pronunciation 
 

Software is a device that usually contains encrypted or coded information or communication for a specific 
purpose. Except coded in the Read-Only-Memory/Mode (ROM), software can be erased and replaced, unlike 
hardware. It serves as a guest to be hosted by the hardware to manifest the purpose of the information encoded in it. 
Software can never be useful without the hardware to drive it. Examples as indicated above are: 14. Cassette 15.CD 
16.DVD 17.PRAAT 18.SFS 19.WASP 20.Speech Analyzer 21.LINGwaves and 22.ProCoach. Items 17-22 are 
specifically digitised linguistic analysis computer software that are deployable for the improvement of the English 
pronunciation. This has led to a body of knowledge now referred to as Digitised Linguistics, and anyone who does a 
consistent linguistic analysis using any software is now referred to as a Digitised Linguist. Studies are many that have 
used many of the software for pronunciation. Some of the champions in this expertise are Josef Schmied, 1995, 
Daffid Gibbon 1996, Peter Ladefoged, 2001; Martins Weisser, 2001; Keith Johnson, 2003; Paul Boersma& David 
Weenink, 2004; Alexandra Thies, 2005; „DemolaJolayemi, 2006, 2008a, 2014, 2015, 2018; Lee, 2008; Peter 
Ladefoged& Keith Johnson, 2011; and AdenikeAkinjobi, 2013a). This list of such software, as stated above is endless, 
but examples are: 14. Cassette 15.CD 16.DVD 17.ProCoach 18.SFS 19.WASP 20.Speech Analyzer 21.LINGwaves 
and 22.PRAAT. The last on the list, PRAAT (item 22), demonstrates how software can be used to improve 
pronunciation, which engages a subsequent section of this paper. 
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Plate 3: Hardsoftware for the Improvement of English Pronunciation 
 

There are some software that come in both hardware and software modes, this is because it is possible to 
have both made for the end-users. Examples of this are: 23. Daniel Jones English Pronouncing Dictionary and 
24.Cambridge English Pronouncing Dictionary. Both of these pronunciation tech can be obtained in the hard and soft 
modes. Furthermore, it may also be that the function of one is highly dependent on the other, almost like a pair of 
things. 25. Language Laboratories and 26. Digitised Linguistics Science Laboratories are a mode like that, which can 
be classified as Hardsoftware. Lastly on this Plate are 27. Films, which can both be obtained as both hard and soft. It 
is to be noted that the English syntax has not yet permitted us to pluralise hardware nor software with the -s plural 
marker. Hence, 1 Hardware as well as 100 Hardware (without the plural marker “s”); and 1 Software is as well as 100 
Software. 
 

Plate 4: Virtual Tech for the Improvement of the English Pronunciation 
 

There are a very useful tech that reside within the realm of the cloud. They are accessible only by the means 
of the internet through specified Universal Resource Locators (URLs), which are good to learn, teach, and improve 
the English pronunciation. Because of their virtual nature, they are also and most commonly called online resources. 
Examples are: 28. The Internet 29. World Wide Websites (www); through which many other online pronunciation 
tech can be obtained, such as: 

 

30.  www.dialectsarchive.com 
31. http://accent.gmu.edu 
32. www.bbc.co.uk/worldservice/learningenglish/grammar/pron/ 
33. www.uiowa.edu/~acadtech/phonetics/about.html# 
34.  https://app.speechace.co/placement/course/1 
35. Podcast, 36. YouTube, etc. 
 

Part Two 
 

PRAAT: 
 

Around 2003/2004, Paul Boersma and David Weenink of the Institute of Phonetics Sciences, University of 
Amsterdam, Netherlands wrote a program named PRAAT, a Dutch word which means “talk” in English. It is, up till 
now, free linguistic software that can be downloaded using the Universal Resource Locator of: 
http://www.fon.hum.uva.nl/praat/download_win.html. The main highlight of the program is that it is multi-task 
software, which is very handy for users of many categories such as: the phoneticians, phonologists, speech 
pathologists, voice coaches, and forensic experts. It can be excited by only sound files in the following formats: AIFC 
files, AIFF files, FLAC files, MP3 files, NeXT/Sun (.au) files, NIST files, and WAV files (Boersma&Weenink, 2013). 
The program has gone through various versions comprising many modifications and improvements; an earlier version 
being 4.404 and the latest 5.3.49.  
 

How PRAAT is Operated 
 

Three initial steps must have been taken before PRAAT can be used. The first is that the user must have downloaded 
the program into the computer, which will present the PRAAT icon in Picture 1 on the computer, as below.  

 
Picture 1: PRAAT’s Icon 

 

Secondly, the user must have a sound file saved in the computer to be imported into PRAAT. To do this, the 
user can use any digitised sound recording device, like The Audacity, saved by Export, to be imported into PRAAT 
later, as done in this study. The user may also directly record a corpus into the computer with the PRAAT Recording 
menu following the steps presented below. Double click the PRAAT icon and receive a pair of windows up on the 
computer screen. On the left is the PRAAT Objects and on the right is the PRAAT Picture, as shown below: 
 

http://www.dialectsarchive.com/
http://accent.gmu.edu/
http://www.bbc.co.uk/worldservice/learningenglish/grammar/pron/
http://www.uiowa.edu/~acadtech/phonetics/about.html
https://app.speechace.co/placement/course/1
http://www.fon.hum.uva.nl/praat/download_win.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_3__AIFC_files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_3__AIFC_files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_3__AIFC_files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_2__AIFF_files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_6__FLAC_files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_7__MP3_files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_4__NeXT_Sun___au__files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_5__NIST_files.html
file:///C:\Users\DR%20DEMOLA\Documents\Elizade\SKY\Sound_files_2_1__WAV_files.html
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Picture 2: Screen Capture of PRAAT Object and PRAAT Picture Windows 
 

The left window, as can be seen, has four menus at the top left corner – PRAAT, New, Read, and Write. 
New is used to record with PRAAT, the one the user needs now, when clicked, giving a direction to record with 

“Record mono sound”: 
 

 
 

Picture 3: Screen Capture of PRAAT Objects and Recording Menus I 
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Another click on “Record mono sound”, the Window to do the internal recording shows up as 
“SoundRecorder”, and the recording done by a click on “Record” that manifests on this new Window as: 
 

 
 

Picture 4: Screen Capture of PRAAT Objects and Recording Menus II 
 

Read to import a sound file into PRAAT. Below the window are five additional menus – Rename, Inspect, 
Remove, Copy, and Info. The PRAAT Picture window on the right is a display window where acoustic pictures are 
shown and where analyses can be performed as indicated on the menus of the window. 

 

The user may wish to record his own sound using PRAAT tool by clicking the New Menu, which gives an 
array of directions that can be dutifully followed. Among the directions under the Menu is Record mono Sound, which 
enables the user to record own sound and save for use with PRAAT. When this recorded sound is saved, it 
automatically comes up on the PRAAT Objects Window. But the user has the appropriate sound file already in his 
computer, the next step is to load it into PRAAT by clicking on the Read Menu of the PRAAT Objects Window and 
follow the directions for the location of the sound. These two actions can originate from the slate below as captured 
from PRAAT Objects: 
 

 
Picture 5: Screen Capture of PRAAT Objects Displaying Key Menus 

 

As soon as the expected sound comes up on the PRAAT Objects, another array of menus show up at the left 
side of the window, namely: Sound help, Edit, Play, Query, Modify, Annotate, etc. when these menu appear, they can 
be applied to the imported sound until the desired objectives are achieved by the user. 

 

Most of the time, PRAAT is used to show acoustic evidence of utterances that one intends to analyse. To 
achieve this we often add textgrids to the corpus of utterances we want to analyse, by clicking on the Annotate menu 
and follow a number of directions until textgrids show up below the sound we had already created. Thus, we have the 
textgrids for “This is Babcock University, Ilishan” whose WAV File, we recorded with the PRAAT recording tool, as 
indicated below: 
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Picture 6: Display of PRAAT Objects Window 
 

To begin to show the acoustic products of the recorded sound, we have to click on the Draw Menu at the left 
side. As soon as we do this, the PRAAT Picture window is filled by the acoustic picture shown below: 

 
Picture 7: PRAAT’s Oscillogram of This is Babcock University, Ilishan 

Time (s)

0 3.367
-0.3754

0.4723

0
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But if you are also interested in filling the picture with additional information such as dividing into segments 
by syllables, annotating orthographically and phonemically like we did here, or any other operation on your mind, you 
will further click the Edit Menu on the right side of the PRAAT Objects, which gives you the opportunities by 
following the menu directions. This will open for you another picture that contains further acoustic information of 
your recorded sound showing the sounds‟ oscillogram in form of waves or what is called excursions. You will also be 
able to obtain the utterance‟ spectrogram, and if you like, display its pitch, intensity and formant by clicking on the top 
menus of this new window called TextGrid. In the segmentation processes, of importance are the directions under 
Boundary, which will enable you to divide up into smaller bits of an utterance such as into words, syllables or isolated 
alphabet, phone or phoneme. You will also find the Tier Menu very useful as it will assist you to add as many levels of 
annotation as you desire for your analysis. If you are able to achieve this, you will have been able to create a similar 
thing we have below which we have achieved by clicking on the File Menu of the TextGrid Window. This will direct 
you to a number of options one of which is Draw visible sound and TextGrid. This leads to Picture 8 that is displayed 
below. 

 
Picture 8: PRAAT’s Oscillogram of This is Babcock University, IlishanWith Annotations 

 

However, you may also want to display the TextGrid window exactly the way it is created, so as to be able to 
show additional information that is not captured in the drawing of Picture 8. This is achieved by simply clicking the 
Click Open, the third menuon PRAAT Objects, then Readfrom file, which will enable you import the already saved 
sound file. Because in an analysis of this type, you need to annotate the sound segments of the utterance, the next step 
is todraw down the Annotation menu on the PRAAT Objects Window in order to click TextGrid, which will allow 
for the annotation, and another line joins the imported sound line. The final stage to commence the annotation is to 
highlight these two lines, go back to the PRAAT Objects Window and click the View & Edit menu. From this point, 
the menus on the newly opened window will assist in the annotation processes, the help menu on the page is also 
definitely of immense assistance. The successful engagement of the described processes will give birth to something 
like Picture 9 presented below:  
 

 

This is Babcock University Ilishan

ðɪs ɪz bæbkɔk ju:niɪvɜ:sətɪ ɪlɪʃən

Time (s)

0 3.367
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Picture 9: Acoustic Dump of This is Babcock University, Ilishan Displaying Oscillogram, Spectrogram and 
Annotations by Orthography and Phonemes 

 

When all is done, the user will locate the File menu of the page and click the Save TextGrid as text File, 
then saves the picture for the future-use. To get a copy on a Windows document as we did in Picture 9, the user may 
then have to resort to what is called Acoustic Dump of the TextGrid, which can be obtained by a screen computer 
capture done by clicking on ctrl+Print Scan of your computer keyboard. The next operation to be performed is to 
open to the Window‟s Paint Artist program in the Accessories of the computer; when this is opened, TextGrid earlier 
print-scanned can then be pasted or dumped. You may employ the menus of Paint Artist to select the portion of the 
TextGrid desired. Following our own illustrative corpus, we have the acoustic dump of This is Babcock University, Ilishan 
in the Picture 9 above. 

 

This is a gist of how PRAAT, as a computer-based technology, is operated; however, we hasten to add that 
there is a lot more to know if users would methodically follow the help file of the program offered by Paul and David. 
There, is information on Picture Window, Special Symbols, Phonetic Symbols, Text Styles, etc.  
 

Summary 
 

With the demonstration and explanation above, we have been able to introduce PRAAT as a computer-based 
tool that is unavoidable in language learning, especially in the class of phonetics and phonology. By this, we hope we 
have motivated the users enough to stimulate them to explore the greatness of the program. We have also been able 
to show what benefit the students and teachers stand to derive, for the engagement of the psychomotor domain. It 
tasks the students‟ practical involvement, healing any moment of dullness, thereby making the class fun. The dreary 
language class, especially, phonology, with its esoteric symbols and technical rules that often lead to rote rather than 
note learning dissolves into a class of happiness. Coupled with techno-maniac tendency of our students, nowadays, 
the digitised language laboratory will be a haven for our active students who desire explorations and innovations in the 
computers. PRAAT offers itself as a linguistic channel for this exploration into the abundant knowledge yet to be 
acquired in the analysis of speech sounds supported by scientific evidence. This, thereby, improves both the (English) 
language receptive and productive proficiencies within the general Computer-Assisted Language Learning linguistic 
ambiance. 
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